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New Features and Enhancements in
Simcenter STAR-CCM+ 2019.3

Realism Productivity Exploration Continuity

• Increase model
sophistication

• Include all relevant
physics

• Elevate confidence in
results

• Save engineering time
• Increase simulation

throughput
• Improve hardware

utilization

• Explore more designs
• Gain analysis insight
• Accelerate design

decisions

• Implement best
practices

• Enable enterprise
collaboration

• Facilitate closed-loop
design

Top new features and enhancements for this release are:

• Combustion for Simcenter STAR-CCM+ In-
Cylinder[1] 

• QuickPart libraries in the Electronics Cooling
Toolset

• Search tool in 3D-CAD[1]

• Simcenter Nastran co-simulation[1]

• Job Manager for Design Exploration
• Transient-transient CHT in multi-timescale

simulation[1]

• Photon Monte-Carlo Radiation[1]

• Graphics checker[1]

1 Posted on IdeaStorm
A total of 25 new features and enhancements from IdeaStorm in this version.
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Enhancements to Simcenter STAR-CCM+ v2019.3 are presented by category:
Platform
CAD Integration
Geometry
Mesh
CAE Integration
Physics
Design Exploration
Data Analysis
Application Specific Tools
User Guide

Platform
Deployment
• Newly certified operating systems (OS)

◦ SUSE Linux Enterprise Server (SLES) 15
◦ Red Hat Linux Enterprise (RHEL) 8
◦ Windows 10 May 2019 Update

• Retiring operating systems (OS) in 2020.1 (15.02)
◦ openSUSE Leap 42.4
◦ SUSE Linux Enterprise Server (SLES) 12 SP4

• Newly certified Message Passing Interface (MPI)
◦ Open MPI 3.1.3

Runtime
• Job Manager

◦ Provides automatic job submission of Design Manager studies with:
▪ Automatic and bi-directional files transfers
▪ Easy and secure management for remote Simcenter STAR-CCM+ servers
▪ Study monitoring without a proxy or SSH tunnel
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◦ For the Administrator (IT or power user)
▪ Easily and securely manage computational resources and user rights
▪ Provide Job Manager key(s) to end users
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◦ For the Simulation engineer
▪ Easily and transparently submit jobs to compute resources without having admin level access
▪ Use Job Manager key(s) to access internally configured scripts directly from the Design Manager

interface

◦ Intuitive administration web interface to manage
▪ Resource groups

▪ Submission templates
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▪ Users
▪ Groups

◦ Integrates with existing cluster management environment
▪ Supported cluster batch systems

- Grid Engine (Univa, SGE, OGE)
- PBS (Pro, Torque/Moab/Maui)

▪ Currently unsupported but planned for a later release
- SLURM Workload Manager
- Platform LSF

◦ Current Limitation
▪ Job Manager is limited to support only Design Manager studies submissions only

User Experience
• OpenJDK 11

◦ Provides continued free distribution and security updates of JDK, following end of public updates for
Oracle JDK Java SE 8
▪ Affects packaging and distribution of JDK by Oracle

◦ Simcenter STAR-CCM+ 2019.3 onwards will be distributed with OpenJDK, starting with OpenJDK 11
◦ No substantial technical differences for users of Simcenter STAR-CCM+

▪ An example of a noticeable difference is the change to Siemens Sans Global as the default font
where previously Lucida was used, for example for the Highlight Caption Font.

• Recently used field functions selection
◦ Save time selecting recently used field functions
◦ In the field function selector, access option to filter ‘Recent Functions’, to access your 20 most recently

used field functions
◦ The filter indicators for selected and unselected items have been redesigned and placed to the right-

hand side of the Recent Functions icon.
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• Groups for Parameters D4512
◦ Reduce thinking time when processing large amounts of similar data sets
◦ Identify parameter of interest faster
◦ Parameters can be grouped with custom grouping, or by common attributes shared between

parameters, such as Dimensions, Tags, or Type

• Simulation Operations improvements
◦ Distinct activation status badging

▪ Different badge indicator for each status: deactivated, activated, or executing

◦ Query-based selection support
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▪ Input parts to Simulation Operations now support definition with query-based selections, saving you
time in repeating the set-up of simulations

◦ "Play through here"
▪ Provides control for testing your Simulation Operation by letting you play the sequence up to and

including the selected operation

◦ Physics enhancements to Simulation Operations (more details in our Physics section):
▪ Adjoint Cost Function selection in the Solve Adjoint operation
▪ Support for multiple Time Scales

• Queries: discover other types of predicate object D5151
◦ Automate your simulation setup and build more flexible queries
◦ The Type predicate now allows selection of Other... types of object, directly in context

▪ Previously, you had to drag and drop the non-listed and desired object from the tree in the query to
access these object types

• Rebranding of auxiliary products and options
◦ Consistency of product names across Simcenter portfolio
◦ Auxiliary product names and associated options were updated in various places in the core interface,

such as:
▪ “Simcenter STAR-CCM+ Power on Demand"
▪ “Simcenter STAR-CCM+ Viewer file (*.sce)”
▪ “Simcenter STAR-CCM+ JTOpen Reader” (add-on licensing option)

• Invoking Comment Editor D5041
◦ Save time when adding Comments by using the Shift+F2 shortcut key: the Comment editor now opens

with Shift+F2, even when the mouse is not hovering over the visible, focused tree object

CAD Integration
CAD-Clients
• Creo and Inventor coordinate systems and reference planes names import
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◦ Broaden access and usage of CAD-Clients parameters to extend automation capabilities and application
range

◦ Transfer customized names for coordinate systems and reference planes
◦ Now available for all CAD-Clients, including Simcenter STAR-CCM+ Client for Creo and Simcenter STAR-

CCM+ Client for Inventor
• CAD-Client version upgrade D5181

◦ Simcenter STAR-CCM+ Client for Creo now supports Creo 6.0
◦ Simcenter STAR-CCM+ Client for NX now supports NX 1847
◦ Simcenter STAR-CCM+ Client for NX now supports Simcenter 3D versions 12 and 2019.1

CAD-Exchange
• Simplify Assembly Structure – Import option

◦ Creates tree structure closer to CAD Assembly Structure
◦ Filter with “Geometry Part” type gives meaningful result
◦ New option "Simplify Assembly Structure" in Import Surface Mesh dialog box

▪ Eliminates unnamed assembly nodes
▪ Moves all content to parent node of the unnamed assembly node
▪ Deletes empty assemblies

◦ Available in both 3D-CAD and Parts import
• PLMXML file import unit

◦ Avoid user intervention if units are already present in import file
◦ Avoid import failure due to wrong import units
◦ Automatically selects the correct units from the JT Open file for PLMXML import
◦ If unit is missing, fallback on option in import dialog box

Geometry
3D-CAD
• Search tool

◦ More easily navigate, prepare and repair CAD models
◦ Allows you to find and filter CAD model data to

▪ Investigate assemblies
▪ Organize model for simulation
▪ Simplify Geometry
▪ Repair CAD

◦ Quickly search on Body Group/Body/Face/Edge by
▪ Shape & size
▪ Geometric properties
▪ Interference, contacts & gaps

◦ Search tool easily toggled on and off anytime in the 3D-CAD scene
▪ Consistent look and feel with surface repair
▪ Search result can be saved as Design Filter
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• Tools > Options for 3D-CAD
◦ Improved user interaction with 3D-CAD scene and tree
◦ Better geometry display resolution
◦ Global options now available for 3D-CAD

▪ Display Resolution
▪ Edge Color
▪ Free Edge Color
▪ Display Edges Independently
▪ Display Named Faces Independently
▪ Display Named Edges Independently
▪ Highlight Bodies in Treeview
▪ Use right click action “Apply Global System options” under 3D-CAD Model to activate global options in

3D-CAD scene

• Body Groups selection in 3D-CAD Scene
◦ Improved model interaction in scenes

▪ Reduced mouse travel and clicks to find a sub-assembly
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◦ Now Body Groups can be interactively selected in the scene
▪ Hold Ctrl-key to add or remove the selection
▪ Body group is highlighted in tree if the global option “Highlight

in Bodies in Treeview” is activated
• Delete Empty Body Groups

◦ Fewer mouse clicks and less tree scrolling to remove all empty Body
Groups

◦ New right-click function “Delete Empty Body Groups”
▪ An empty body group is one that has no child body groups or bodies
▪ Can be created during import or while organizing the data
▪ Attribute Feature created for this operation

• Edge Chain selection
◦ Easier edge selection for Bridge Surface, Extend Surface, and Fill Hole operations
◦ Possibility to select a chain of edges

▪ Select start edge using left mouse click
▪ Select end edge of chain by pressing shift key while you click

◦ To continue growing the chain, select the next end edge using left mouse click and shift key
• Sphere and Cone as Solid Primitive Shapes

◦ Create a sphere or cone in a single operation
• Optional Guide Body for Bridge Surface

◦ Avoid unintentional result from Bridge surface operation
◦ New check box "Use Sheet Body as a Guide Surface"

▪ The guide sheet body must be located close to the Source/Target edges of the bridge surface
▪ The sheet body is used to guide the bridge surface operation and so increase the likelihood of a

successful bridge and sew
• Edge Operations – CAD Repair

◦ Easily remove unwanted edges that may affect meshing
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◦ Improved success rate for boolean, split or freeform operation
◦ Remove Redundant Edge

▪ Remove redundant or hanging edges from defeature or imprint operation
◦ Optimize Tolerant Edge

▪ Imported model can have high tolerance which can affect operations
▪ Automatically assigns optimized tolerance value

◦ Body, face, or edge can be selected as input for both operations

Parts
• Tolerance in CAD Boolean Operation

◦ More reliable CAD Boolean operation
▪ Extended user control

◦ New option "Tolerance" available for Unite, Subtract, and Intersect Operations
▪ Unite: "Tolerant Faces & Edges”
▪ Subtract/Intersect: “Tolerant Edges"

Mesh
Surface Mesh
• Local Wrapping – Inflation Layers for Surface Extent

◦ More reliable local wrapping operation
▪ Extended user control

◦ Inflation Layers is exposed as a property under the surface extents
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▪ Default -1, consistent with previous versions
▪ Choose to grow inside (-values) or outside (+values) surface extent for stitching

• Surface Wrapper/Local Wrapping – Find Volume of Interest Seed Point
◦ More robust surface wrapping / local wrapping

▪ More robust calculation of Volume of Interest – can now handle seed points located close to surface
◦ Improved algorithm for seed point handling
◦ No UI changes

Volume Mesh
• Parts based generalized cylinder mesher D2147

◦ Improved workflow for meshing of cylindrical geometries
◦ Previously Generalized Cylinder Mesher could only be used in regions when creating polyhedral meshes
◦ Now available in automated mesh operation

▪ Supports polyhedral and tetrahedral cells
▪ Use surface control to customize settings or disable Generalized Cylinder Mesher on specific parts
▪ Right-click action “Execute Cylinder Auto-detection” to determine which parts are identified as

cylinders prior to meshing

Simcenter STAR-CCM+ 2019.3  |  New features and enhancements

Siemens PLM Software 13



• Improved prism layer transition in Advancing Layer Mesher D3704
◦ Improved mesh quality for Advancing Layer Mesher when using different number of prism layers at

adjacent surfaces
◦ Previously prism layer tended to retract between surfaces with different number of prism layers
◦ Now gradual addition of layers obtained

▪ Note: Enough faces for transition required, typically one face per added layer

• Curvature refinement for Directed Mesh
◦ Easily refine directed mesh in curved sections, for example, pipe bends
◦ Possibility to specify number of points per circle in directed mesher
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▪ Available when using size-based layer thickness specification
▪ Automatic growth of layers from highly curved to less curved regions through Growth Rate

• Conformal Tetrahedral Mesh between operations D3235
◦ Achieve a conformal mesh between two mesh operations for tetrahedral meshes
◦ New option "Conformal To Existing Mesh" under mesh operation Expert properties

• Automatic Removal of features prior to meshing with Directed Mesher
◦ No need to remove undesired feature lines for high quality mesh
◦ Automatic removal of features prior to meshing instead of glossing after meshing

• Default value of Minimum Face Quality for Automated Source Mesh in Directed Mesh Operation
changed from 0.05 to 0
◦ To avoid mesh failure due to source mesh not matching the part topology

• Improved robustness and performance for 2D Meshes and Automated Source Meshes for cases with
widely varying cell size
◦ Algorithm for 2D meshing improved to better handle cases with very aggressive growth from the

surfaces to the far field

CAE Integration
• Simcenter STAR-CCM+ to Simcenter Nastran Co-Simulation

◦ Improve simulation realism accounting for fluid-structure interactions in components by coupling best-
in-class tools to solve fluid and structural problems
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◦ Leverage compute hardware effectively for co-simulation cases, for example:
▪ Run Simcenter 3D on Windows desktop with lots of memory

▪ Run Simcenter STAR-CCM+ on a LINUX cluster with many cores

◦ To run a co-simulation job, you have two options
▪ Launch each product separately and manually connect, or
▪ Let Simcenter STAR-CCM+ launch and connect to Simcenter Nastran

◦ Both products are run in a server mode, permitting you to:
▪ Change coupling settings on the fly
▪ Get synchronized restart information

◦ Support is provided for

Simcenter STAR-CCM+ 2019.3  |  New features and enhancements

Siemens PLM Software 16



▪ Shell and continuum elements
▪ Explicit coupling

◦ Known Limitation
▪ Implicit coupling is not currently supported

Physics
CFD
Multiphase Flow
Computational Rheology
Computational Solid Mechanics
Electromagnetics and Electrochemistry
Aeroacoustics
Motion, DFBI, Overset, and Mapping

CFD

Flow
• Multiple Time Scales in Simulation Operations D1249

◦ Improves ease of use in multiple time-scale cases where the same time solver is used in multiple
continua
▪ For example, Conjugate Heat Transfer (CHT) cases with a transient solid and transient fluid

◦ New timescale objects are introduced for setting up multiple time-scale stopping criteria for each
continua
▪ When a single time solver is used in multiple continua

◦ Currently active stopping criteria can be easily visually identified
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• Multiple Fixed Steps and Fixed Physical Time stopping criteria under a single runnable solver
◦ Increases flexibility in setting stopping criteria for multiple time-scale runs

▪ In scenarios where more complex AND logic and OR logic is required
- To combine fixed steps/physics time stopping criteria with monitor stopping criteria
- For example "Run at least X time-steps AND require a monitored quantity to change by at least by

a specified percentage, but do not exceed Y time steps"
◦ Reduces runtime in CHT cases

▪ Flexibility in stopping criteria can be used to reduce the exchanges between fluid and solid
• Phase-specific CHT for internal interface in Phasic Porous Media

◦ Improves physical realism
▪ Modified solver behavior for cases that have same porous (solid) phase existing across an internal

interface
◦ Per-phase conjugate heat transfer for porous phases existing across an internal interface

▪ CHT treatment to handle situation where there is a jump in porosity and volume fraction of porous
phase

▪ Adiabatic if the porous phase only exists on one side of the interface
• Anisotropic diffusion for porous media and solid conduction D736

◦ Improves workflow for setting up anisotropic porous media tensor profiles
▪ Avoids repeated specification of orientation per tensor profile

- New local orientation can be shared by all tensor profiles
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▪ Better naming of tensor profile methods (Orthotropic, Anisotropic, Transverse Isotropic)
◦ Improves workflow for setting up anisotropic thermal conductivity for solid regions and porous (solid)

phases
▪ Consistency in setting up of anisotropic material properties for FV & FE

- Values are specified at physics continuum level
- Orientation is specified per region

• Speed up of unsteady coupled solver
◦ Improved computational efficiency

▪ Up to 1.4x speed up of the coupled solver using default settings for unsteady flows

Energy
• Photon Monte Carlo surface radiation model D4294

◦ Improves physical realism
▪ Expanding capabilities for thermal radiation to

handle refraction, reflection, emission and
absorption
- Benefits headlamp applications where

refraction is required
▪ Improves efficiency compared to DOM with

refraction
▪ The Surface Photon Monte Carlo is a very

accurate statistical tool for predicting radiative
properties
- In the surface model boundaries participate

via emission/reflection/absorption/transmission
- Allows presence of solar loads (direct and diffuse)
- Allows load due to environment conditions

▪ Acceleration methods for steady state solutions
- Intelligent statistical sampling method and emission sampling

Reacting Flows
• Non-Adiabatic (Steady Laminar Flamelet) SLF model

◦ Improved accuracy in the calculation of species concentrations, such as OH, when using the Steady
Laminar Flamelet tabulated combustion model for simulations with departure from adiabatic conditions

◦ Previously SLFs were calculated at adiabatic conditions
▪ New table dimension "Heat Loss Ratio" which allows for non-adiabatic effects on species

◦ When species concentrations such as OH are now looked up in the table heat loss or gain is accounted
for
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• Steady-State Complex Chemistry with Turbulent Flame Closure (TFC)
◦ In steady-state, model the premixed flame location with a turbulent premixed flame speed model
◦ Access by selecting Complex Chemistry for the Reacting Species Model and Turbulent Flame Closure for

the Turbulence Chemistry Interaction model
• Soot Moment Model in Combustion Reactor Networks.

◦ Quick assessment of soot emissions in gas turbines or burners
◦ Soot is a slowly forming pollutant where nucleation depends on complex (aromatic) species whose

accurate prediction requires a detailed chemical mechanism
◦ Using Reactor Network model yields a large speed up when compared with complex chemistry

• Ambipolar diffusion model and material property
◦ Ambipolar diffusion is a species migration model, where positive and negative ions/electrons are

assumed to migrate at the same rate
◦ Plasmas can now be modeled with greater accuracy using this model
◦ Previously field functions were necessary to model the molecular diffusivity property
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• Improved accuracy in Sub-Grid Spark model
◦ The sub-grid spark kernel has now been made to be less mesh dependent

▪ This is achieved by modifying the underlying spark kernel to allow for mesh topology

• Consistent flamelet table dimensions defaults
◦ The default settings for flamelet table dimensions have been changed to be consistent across all table

types
◦ The default maximum sizes for an adaptive table are:

▪ The maximum number of Heat Loss Ratio points is 21
▪ The maximum number of Mixture Fraction points is 101
▪ The maximum number of Mixture Fraction Variance points is 31

◦ The default sizes for a non-adaptive table are:
▪ The number of Heat Loss Ratio points is 21
▪ The number of Mixture Fraction points is 101
▪ The number of Mixture Fraction Variance points is 31

• Reformulation of PISO residual for Combustion Scalars (mixture fraction, progress variable, ECFM)
◦ Normalization of the PISO residuals via cell volume

▪ Adequately converges the PISO loop in cases with relatively small cells
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• Surface chemistry improvements:
◦ An improved Analytical Jacobian calculation

▪ Improved performance of between 1.05-1.2x depending on the surface mechanism used
▪ This is achieved by improving the gradient calculation which is used to estimate the reaction source

term
◦ Multiple surface sites can now be used with CVODE

▪ Previously in order to use multiple surface sites within surface chemistry it was necessary to use
DARS-CFD as a solver

▪ Now it is possible to use the improved performance benefits of CVODE to solve these problems
◦ The surface chemistry node tree has been simplified

▪ An unnecessary node ‘Models’ within the surface mechanism has been removed.
▪ This improves the navigability of the tree
▪ No Java macro changes are required

• DARS-CFD Retirement
◦ The functionality of DARS-CFD has now been fully replicated using the superior solver CVODE in

Simcenter STAR-CCM+ 2019.3. Consequently, it is planned to retire DARS-CFD in Simcenter STAR-CCM+
2020.1

Turbulence
• High-Re support for the Gamma-ReTheta transition model D4780

◦ The Gamma-ReTheta model was originally calibrated for low Reynolds numbers, and the calibration
constants were previously not available to modify

◦ Now these constants are exposed in the user interface, which enables extending the range of
applicability of the Gamma-ReTheta transition model to high Reynolds number flows

◦ This enhancement targets aerospace and wind turbine applications with transition at high Reynolds
numbers

Multiphase Flow

Volume of Fluid (VOF)
• Adaptive Time-Step Provider for VOF Multi-Step D4203

◦ Reduced computational expense for a given level of accuracy
◦ Improved ease of use

▪ No need to determine a universally stable time-step size
◦ Targets number of cells for interface propagation

▪ Allows for variation of CFL number whilst interface is transported across multiple cells
▪ Aims to deliver relatively constant number of sub-steps
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◦ Applications include tank filling, gearbox and tank sloshing, and marine free surface simulations

• Improved Mass Balance for VOF
◦ Improved accuracy as a result of improved numerical schemes

▪ Reduces systemic mass imbalances due to lack of convergence in transient runs
▪ Previously under-resolved transient runs could accrue a significant mass imbalance over time due to

consistent sign of mass error
◦ Particularly benefits closed domains and domains with large volume to inflow ratio

Eulerian Multiphase (EMP)
• Discrete Quadrature S-Gamma Model

◦ More accurate modeling of break-up and coalescence when using S-Gamma
◦ Two options provided for S-Gamma Closure:

▪ Discrete Quadrature S-Gamma (new)
- Supports additional break-up and coalescence models via continuous-dispersed phase interaction

previously only available for the A-MUSIG model:
* Break-up models provided – Coulaloglou and Eskin, Power Law, Tsouris and Tavlarides
* Coalescence models provided – Luo, Coulaloglou and Eskin

▪ Pre-Integrated S-Gamma (existing model)
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• Improved Interphase Mass Transfer handling of Minimum Volume Fraction Limit
◦ Improved accuracy in cases where minimum volume fraction is used

Fluid Film
• Deprecation of the Thin Film Model

◦ The Thin Film Model has now been deprecated (marked to be retired in a future release)
▪ This model is no longer being developed, is not the preferred model for applications with a thin liquid

film, and will be removed in a future version of the software
▪ The Fluid Film model should be used in place of the Thin Film model

◦ If you have workflows that you feel cannot be adequately covered by the Fluid Film model, and for
which you believe the Thin Film model is the only option, please contact your Dedicated Support
Engineer

Lagrangian Multiphase (LMP)
• Splash mode on boundaries

◦ Improved accuracy/realism for Lagrangian wall impingement
◦ Splash mode is an option for Physics Conditions on boundaries

▪ Allows splashing as a controllable outcome of wall impingement
◦ Splashing mode is compatible with Bai family impingement models

▪ Can be used to customize impingement regime map in existing Bai
family impingement models

◦ Accepts user input for
▪ Number Splashed
▪ Diameter Ratio
▪ Splashing Angle
▪ Velocity ratio

◦ Applications include vehicle water management, Selective Catalytic Reduction (SCR), and fuel sprays
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• Dependencies between particle properties in injector
D3306
◦ Improved accuracy and realism of particle injection

▪ Allows Lagrangian particle properties to be correlated
at injection such as:
- Velocity, diameter, mass, temperature, passive

scalar, injection direction, species mass fraction,
particle charge, DEM cylindrical particle shape
parameters, and other properties

▪ Dependencies introduced by using Field Function
method to specify dependent property

◦ Can reduce parcel count in simulations focusing on
particle-wall interactions by placing injector part closer to
boundary and imposing diameter-velocity or other
correlations on injected particles

◦ Applications include Selective Catalytic Reduction and
fuel sprays in ICE simulations

Discrete Element Method (DEM)
• New methods for setting the bond strength parameters

◦ Expanded regime coverage of Simple Failure Model and
Constant Rate Damage Model

◦ Useful for simulating breakage of anisotropic materials
using either Parallel Bonds model or Bonded particles
model
▪ In anisotropic materials the bond strength between

particles depends on the orientation of the bond
◦ Bond Tensile Strength, Bond Shear Strength, Bond

Strength, and Initial Damage parameters can be
specified using one of the following options
▪ Constant
▪ Field Function
▪ Table (four types)
▪ Normally or Uniformly distributed
▪ User Code

Computational Rheology
• Source Terms for Computational Rheology

◦ Model a wider range of applications through the inclusion of momentum and energy source terms for
the Viscous Flow Solver
▪ Can include the effects of porous media or sub-grid effects
▪ Aligns capabilities with Finite Volume flow solvers
▪ Mass sources not provided

◦ Applications include Resin Transfer Molding (RTM)
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• Surface Tension between Co-Extruded Fluids
◦ Improves accuracy by correctly accounting for the interfacial tension between co-extrusion layers

▪ Dedicated surface tension model for co-extrusion
- Previously surface tension was only accounted at free surface/wall boundary intersection
- Now considered between fluid layers in a co-extrusion simulation

◦ Two options available at the interface:
▪ Constant (supplied at interface)
▪ Good Girifalco Fowkes (calculated based on material values)

Computational Solid Mechanics
• Solid Stress Load Step Solver

◦ Improved convergence/stability for non-linear problems:
▪ Non-linear geometry
▪ Non-linear materials

- Hyper-elasticity
- Plasticity

◦ Load loop is sub-stepped within the solver loop
▪ Allows non-linear effects to be stably handled in a single solver step

• Non-Conformal Interface - Surface to Surface Constraint Mapping for Heat Fluxes
◦ Improved accuracy for FE solid energy heat fluxes
◦ Surface to surface mapping now also works with FE solid energy

▪ Tessellates intersection of meshes giving faces on which fluxes can be conserved
• Field Functions for Thermal Conductivity

◦ Model more applications with FE energy where the thermal conductivity is varied via a field function
▪ Allows for temperature dependence
▪ Allows spatial variation due to composite or anisotropic materials

◦ Applications include CHT of turbine blades or heat exchangers

Electromagnetics and Electrochemistry

Electromagnetics
• "Line Search" method implementation

◦ Improves convergence robustness for non-linear problems (like with e-machines) within the Finite
Element Magnetic Vector Potential solver by searching for the maximum URF which ensures
convergence

◦ In some cases Line Search may improve the computation speed
◦ The "Line Search" is enabled and managed under the Magnetic Vector Potential solver settings with the

two following methods:
▪ None: This is the default method, no Line Search is performed
▪ Energy Reduction: Line Search is enabled and performed to find the optimal URF value

◦ When enabled, Line Search execution is controlled by the following properties:
▪ Cutoff Residual: When the Energy Norm has dropped below the specified value, no further Line

Search is performed
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▪ Cutoff Iteration: When the inner iteration number (transient solution) or step (steady solution)
exceeds the specified value, no further Line Search is performed

▪ Verbosity: When selected, prints out additional Line Search output about convergence and energy
values

◦ Known limitations: Non-conformal interfaces are not supported with this new functionality
• Additional Norms and Monitors for the Finite Element Magnetic Vector Potential Model

◦ This new feature improves the convergence monitoring and gives you greater flexibility in defining the
convergence criteria
▪ Helps you identify local or global errors that may occur due to bad cells and so decide whether to

ignore them or not
▪ Identifying non-critical local problems can help get a time step to convergence with fewer inner

iterations
◦ Two new norms have been added to the existing Euclidian Norm of the residual vector

▪ The Max Norm and the L1 Norm can now be selected as alternative evaluation methods of the
residual vector

◦ Also a new monitor of the magnetic energy physical quantity has been added which gives a deeper
insight on the convergence behavior
▪ The Magnetic Energy Monitor can be enabled with a tick box under the Magnetic Vector Potential

solver settings

• Temperature dependency for ferromagnetic material permeability
◦ Allows you to account for the temperature dependency of permeability in ferromagnetic materials

▪ Enabling this option provides you with an increased model fidelity
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◦ The temperature dependency comes as a new option under the solid materials property definition for
the permeability

◦ This option is particularly useful in the case of induction heating
• Compute nodal forces with the new "Magnetic Nodal Force" model

◦ A dedicated model has been developed to compute and analyze the magnetic nodal forces
(concentrated forces acting on the nodes of a FE mesh) on a part subject to a magnetic field
▪ Enables a more detailed control on where the forces are calculated

◦ Forces are computed with the selection of the Magnetic Nodal Force model
◦ Nodal forces are computed on the region of interest for each node, but an option to only compute them

on the parts boundary can be selected to reduce the calculation weight for larger models
▪ Computation on boundaries is particularly useful to compute nodal forces at material interfaces, such

as the stator/air interface for e-machine; used for vibro-acoustics analysis
◦ At interfaces, Magnetic Nodal Forces are only displayed if the model is selected on both side of the

interface

• Motion Induced Voltage option for Excitation Coil Circuit Element
◦ Improves user experience with a much simpler setup than in the previous version which required a more

convoluted workflow
◦ Excitation Coil Circuit Element has a new Voltage source option

▪ The ability to specify a voltage source to compute the motion induced voltage in the coil is
particularly useful as previously you had to create a Voltage Source circuit element in series to the
coil circuit element and a field function intensive setup to make it work

▪ The voltage source initial condition option is accessible under the Circuit Solver folder in the
Excitation Coil Circuit Element properties used to help compute the motion induced voltage in the
coils

◦ Also several reports monitoring the circuit element can be created from it
▪ Reports are automatically generated under the report folder, providing a more natural workflow
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Electrochemistry
• Secondary Current in Fluid Films D4434

◦ Improved accuracy when modeling atmospheric corrosion
◦ Previously it was only possible to simulate the effects of resistance caused by the electrodynamic

conductivity of the solution
▪ Now the effects of electrochemical kinetics can be included using Electrochemical reactions in the

Fluid Film
• Increased stability for electrochemical reactions in MMP

◦ Now possible to model flooding in fuel cells
▪ Previously these operating conditions were difficult to model since the volume fraction of water was

close to 1
◦ Flooding can now be simulated with fewer iterations since the simulations have improved stability
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• Improved copy and paste behavior for electrochemistry continua
◦ Significant improvement in copying and pasting a physics continua containing an electrochemical

surface reaction

Aeroacoustics
• Option to disable periodic FW-H

◦ Since v11.04, periodic boundaries are automatically detected by FW-H, allowing for instance a full fan
noise calculation using a single fan blade

◦ A new option for ’Periodic domain’ is added
▪ If enabled, source surfaces on periodic domains will be copied into a full 360 deg surface
▪ If disabled, the source surface from a single segment is treated as-is
▪ In case no periodic domains are detected, the option has no effect

◦ The new options allow you to disable the existing periodic FW-H method for specific applications, such
as beamforming

Motion, DFBI, Overset, and Mapping
• Improved mass conservation for overset VOF applications

◦ Significantly improved mass conservation for segregated single phase and VOF multiphase simulations
in closed systems using overset meshes
▪ Prior to 2019.3, mass conservation was available only for segregated single phase open systems, and

closed systems with low compressibility
▪ Beginning with 2019.3, the mass tracking overset conservation option is available for single phase

and VOF multiphase in closed systems with high compressibility
◦ Mass tracking overset conservation option is available under Physics > Models > Overset Conservation

▪ Compatible with segregated single-phase and multi-phase VOF
- Source terms are used to conserve mass for segregated single-phase flow and volume integrated

volume fraction for multi-phase VOF
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• Avoid morphing boundary layers on rigidly moving walls D3222
◦ Preserves quality of moving boundary layers

▪ Improved solution accuracy at the wall boundaries
▪ More accurate wall heat flux/wall y+ in the prism layers attached to rigidly moving boundaries

◦ Morphing the prism layers near moving boundaries may result in cells with poor quality and high
skewness values

◦ The new Rigid Prism Layer Morphing option can be applied on region boundaries, available under the
Region > Boundary > Physics Values node
▪ Keeps the prism layers intact and only morphs the cells away from the rigidly moving walls

• Improved interpolation for steady overset interfaces D5273
◦ Potential to accelerate convergence when running design variations of configurations using steady

overset interfaces
▪ Improved initialization of cells for steady overset interfaces undergoing region level transforms
▪ Prior to 2019.3, inactive cells were being interpolated from the initial values, which may not provide

a good initial guess
▪ Beginning with 2019.3, interpolation is now being done from the surrounding cells

• Capture transient effects in virtual disk, blade element method D5274
◦ Lower computational cost and reduced cell count compared to resolving the blade mesh

▪ For ROBIN helicopter case, a speed up of 6.5x was observed, compared to motion modeling using
overset mesh where the blade mesh is resolved

◦ Capture transient effects for helicopter rotor and propeller flows, for example, vortex shedding, shaft
and fuselage loading, and interactional aerodynamics
▪ At each time step, the transient blade element method moves the source terms around the

circumferential direction and feeds back the resulting forces to the background mesh
▪ Ability to switch to unsteady from steady setup for minimum computational time
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• Extend user defined tip correction for virtual disk, blade element method D4604
◦ Possibility to specify realistic inflow at the blade tip

▪ Improved customization
◦ You can specify if lift, drag, or Angle of Attack correction is applied at the tip resulting in more physical

inflow at the tip
◦ In 2019.2 and prior versions, User Defined Tip correction was applied only to the variable lift
◦ 2019.3 onwards User Defined Tip correction is extended to apply to drag, or angle of attack, or both lift

and drag
• Solution interpolation model selection

◦ Consistent and intuitive selection of solution interpolation models for mapping
◦ Single solution interpolation model capturing all the required controls
◦ Improved workflow and model selection for solution mapping

▪ Previously (in 2019.1 and 2019.2), Proximity Interpolation and Conservative Interpolation were
available as either/or options under Physics > Models.

▪ Starting in 2019.3, a single solution interpolation model captures both the options available under
Physics > Models > Solution Interpolation

◦ Backward compatibility provided
▪ If Proximity Interpolation Model was selected in older version of sim file, it will be transitioned to

Solution Interpolation Model with Conservation Correction set to Disabled.
▪ If Conservative Interpolation Model was selected in older version of sim file, it will be transitioned to

Solution Interpolation Model with Conservation Correction set to Enabled.
▪ Macros must be updated
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Design Exploration
Adjoint
• Cost functions usability improvement

◦ Improve automation especially for multi-objective optimization
▪ Easier and more intuitive way of setting up multi-objective cases
▪ Decision making on which cost functions to optimize in Simulation Operations level

◦ Added capability under individual cost functions
▪ Step/run
▪ Clear solution
▪ Computing additional fields

- Surface and Mesh Sensitivity and Error Estimates
◦ Simulation Operations

▪ In Solve Adjoint automation block
- Select the Adjoint Cost Functions to solve for in

the Properties tab
▪ The "Compute mesh adjoint" property is renamed to

the more suitable "Compute Mesh sensitivity"

Design Manager
• Single mesh operation for same geometry variants D4631

◦ Reduce overall exploration time by only generating meshes when needed
▪ Parameter Simulation Effect property identifying which parameters affect meshing operations
▪ Automatic ordered submission starting with designs needing a mesh generation first
▪ Reusable mesh automatically stored in cache memory for a future usage across the study based on

Parameter Simulation Effect value
▪ Support for Design Sweeps and Manual Studies only and even if .sim files are not saved
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• Auto Save option moved to project level
◦ Save time and avoid likelihood of errors

▪ Auto save option set at project level instead of study one

• File browser support in Manual Design Table
◦ Increase ease of use and reduce likelihood of errors

▪ File browser available from Manual Table for a quick file parameter selection
• Macro sub-menu in File menu

◦ Save time by quickly accessing macro options from the File menu
◦ Ensure consistency with .sim files
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• STAR-Innovate rebranding
◦ Updated naming to ensure consistency across Simcenter portfolio
◦ All functionality and user interface stay the same as previous versions

▪ Simcenter STAR-CCM+ Intelligent Design Exploration

Data Analysis
• Sliding Window for Plot axes D516, D1270

◦ Understand iteration/timestep trends by limiting plot clutter
◦ Identify variations on inner iterations more easily
◦ A new range mode can be applied to the abscissa/ordinate for Monitor plots

▪ “Data Bounds” preserves previous release behavior (default)
▪ “Sliding Window” shows only the last N units (for example, time steps or iterations)

- Monitor plot is updated while solver is running

• Dedicated Rendering Service
◦ Use your high performance graphics resources with Simcenter STAR-CCM+
◦ Dedicated Rendering Service connection options include:

▪ Launch and connect at Simcenter STAR-CCM+ session start-up, OR
▪ Launch a standalone Dedicated Rendering Service from the command line

- Use either bin/starrenderer (LINUX) or bin\starrenderer.bat (WINDOWS)
- Command line switches for starrenderer provide further control and flexibility

◦ Dedicated Rendering Service can be used in two ways
▪ Simultaneously, by multiple users or servers (default)

- Render jobs are queued to avoid overwhelming your dedicated graphics resource
- The Dedicated Render Service stays available and needs to be explicitly terminated when no

longer needed
▪ Single user mode

- When a single user session completes, the Dedicated Render Service is automatically terminated
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• Graphics Checker D2256
◦ Ensure that the best graphics resources are automatically identified to guarantee that:

▪ Renders (hardcopies, refresh updates) are completed as fast as possible
▪ Failed renders are far less likely to happen

◦ Identification of the best graphics resource on start-up is automatic
▪ A prescribed interrogation process is run based on your renderer choice (Client, Server, or Dedicated

Service)
▪ Command line switches are available to override automatic detection

◦ For client-side rendering for Simcenter STAR-CCM+ and Simcenter STAR-CCM+ Viewer
▪ Section at left in figure below shows automated Graphics Checker interrogation process

- Preferred choice is identified as OpenGL
▪ If Graphics Checker unexpectedly returns MesaGL, section at right in the figure below shows the

manual override option

◦ For remote rendering (on LINUX), Graphics Checker does an additional check for EGL/OpenGL
▪ Section at left in figure below shows automated Graphics Checker interrogation process

- Preferred choice is EGL/OpenGL, secondary choice is OpenGL
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▪ If Graphics Checker unexpectedly returns MesaGL, section at right in the figure below shows the
manual override options
- EGL is recommended as the first override choice
- Native graphics override requires an active X session with GPU support to succeed

• Motion Support for Graphics Transforms D1666, D4088
◦ Improves workflow & capability for problems investigating motion support
◦ "Motion Transform" is now available per displayer
◦ Currently limited to rigid motions only

▪ Translations & Rotations
▪ 6DOF body motion for DFBI

◦ Workflow for setting up a motion transform requires three steps

◦ Simple example
▪ (see left) Solver can be used to drive the motion; displayer objects follow solver settings
▪ (see middle) Solver can be used to drive the motion; an inverse motion transform can offset the

solver motion
- Displayer objects that are moving can be forced to stay within the scene

▪ (see right) A motion transform can be used to preview the pre-defined motion
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• First Person Interaction D3293
◦ Navigate scenes more freely and intuitively

▪ Overcome ergonomic shortcomings of using a right-handed mouse & keyboard simultaneously
◦ The WASD convention for first person interaction is provided as a new Interaction Style

▪ Select via Tools > Options > Visualization > Interactor Style > First Person
▪ Note: The right-mouse button must be held down to transform scene contents

Application Specific Tools
Simcenter STAR-CCM+ In-Cylinder Solution
Electronics Cooling

Simcenter STAR-CCM+ In-Cylinder Solution
• Rebranding

◦ The STAR-ICE brand has changed to Simcenter STAR-CCM+ In-Cylinder Solution. The name may be
truncated for readability to “In-Cylinder” in certain locations within Simcenter STAR-CCM+

• ECFM-3Z Combustion with FI Spark-Ignition Model

Simcenter STAR-CCM+ 2019.3  |  New features and enhancements

Siemens PLM Software 38



◦ It is now possible to perform basic gasoline direct-injection engine performance simulations
◦ Selecting “Combustion” in the “Model Selection” panel enables the ECFM-3Z combustion model and the

FI spark-ignition model
◦ Ignitors can be generated quickly and easily via the “Engine” node. Through the “Ignitor” edit panel it is

possible to:
▪ Name the ignitor
▪ Position the ignitor with visual feedback in the scene
▪ Specify spark timing, spark duration, and spark model constants

◦ The lower heating value of the fuel can be set through the “Fuel” node when a single-component fuel is
used

• KHRT Breakup Model Setup
◦ The commonly-used KHRT breakup model can now be selected from the “Model Selection” panel
◦ Model parameters can be easily specified through the "KHRT Breakup" edit panel under “Models"

• Valve-Specific Lift Closure Tolerance
◦ The lift closure tolerance can be set individually for each valve through the "Valve" edit panel
◦ It is now possible to consider aspects of valve/seat geometry, variability between intake and exhaust

valves, and long valve lift ramps
◦ The "Auto Time Step Settings" panel now has valve lift controls specified as offsets relative to the lift

closure tolerance
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• Cyclic Time Units
◦ “degCA” has been introduced as a new cyclic time unit using the native implementation in

Simcenter STAR-CCM+
◦ “degCA” can be used directly in reports and annotations; there is no need to create a field function to

convert between time and degrees crank angle

• Improved Handling of Parts and Geometry
◦ The Valve/Cylinder Quick Parts have been moved into the top-level of the 3D-CAD tree, providing a faster

workflow when a new construction object is added in the In-Cylinder tree (for example a sphere or
cylinder for a volume control for mesh refinement around the spark plug)
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Electronics Cooling
• ODB++ Reader

◦ Improves interoperability for electronics cooling analysis
◦ Allows for electronic assemblies to be imported from ECAD tools

▪ ODB++ is an industry standard data exchange format
◦ Import of QuickPart assemblies including trace layer images in PCBs

▪ IDF import panel is displayed to allow the user to down-select the imported components and
automatically filter based on size

▪ The imported assembly includes standard QuickPart types as well as trace layers within the PCB
◦ Importer available as a separate download through the customer portal

▪ Once downloaded and unpacked, the location is specified in e-cool
• QuickPart Libraries

◦ Reduces turnaround time by enabling storage and re-use of user-defined QuickParts
▪ Quickparts can be easily stored and recalled from libraries

◦ Storage of QuickParts allows for standardization of setup and reduced opportunity for input errors
▪ QuickParts stored in a PLMXML type library
▪ Custom library path may be defined under Tools > Options > Environment
▪ Allows central repository for all users
▪ Multiple libraries supported to improve organization

◦ QuickParts may be stored and recalled by type
▪ Easily filtered by type/name/tag

User Guide
• New Tutorials

◦ Geometry
▪ 3D-CAD Defeature and Repair using the European Truck

◦ Mesh
▪ Gap Closure in Surface Wrapper: Drone Main Body

◦ Incompressible Flow
▪ Simulation Operations: S-Bend Shape Optimization

◦ Motion
▪ Trajectory Motion: Paint Dipping of a Chassis on a Fixed Skid

◦ Coupling with CAE Codes
▪ Simcenter Nastran Co-Simulation: Disc Valve

◦ Simcenter STAR-CCM+ In-Cylinder
▪ Gasoline Engine: ECFM-3Z Combustion

• Modified Tutorials
◦ Steady Flow: Laminar and Turbulent Flow in an S-Bend – Now uses the parts-based generalized cylinder

mesher
◦ Viscoelastic Flow: Basic Extrusion – Changed to use double-precision and the BSpline morpher
◦ Porous Resistance: Isotropic Media – User interface updates
◦ Porous Resistance: Orthotropic Media – User interface updates
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◦ Gasoline Engine: Motored – Valve curtain interface position changed to 55.0; new Operating Conditions
node

◦ Gasoline Engine: Charge Motion – Modified fuel composition; new Operating Conditions node
◦ Eulerian: Hibiki’s Bubble Column – Modified setup

• Retired Tutorials
◦ 3D-CAD: Cyclone Separator
◦ Basic Gravity Sand Casting
◦ Adjoint Flow Solver: Flow through an S-Bend
◦ Eddy Break-Up: Coal Combustion (replacement tutorial expected in future release)

• New Case in the Verification Suite
◦ Lagrangian Multiphase > Droplet Atomization
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